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NEW QUESTION 1
What four actions do the as-delivered Service Request components included in a Digital Customer Service (DCS) application enable a DCS user to do?

A. Chat with an Agent about a Service Request.
B. View and edit attachments to a Service Request.
C. Create a Service Request.
D. Delete a Service Request.
E. Add a message to a Service Request.

Answer: ABCD

NEW QUESTION 2
Select three correct limits and restrictions when importing data from a file.

A. Both create and update operations are available for imported records.
B. By default, the import starts immediately after it is activated.
C. Groovy Scripts and object workflows that have been configured for the object being imported are always executed.
D. The maximum number of records in each CSV file should not exceed the maximum limit of 10,000,000 records.
E. If the values in the imported CSV file contain a new line character, then they must be enclosed within quotation marks.

Answer: ABC

NEW QUESTION 3
What three things should you do once you have established a global default coverage?

A. Create an ESS job to Monitor Service Request Milestones.
B. Create an ESS job to Aggregate Service Requests.
C. Use Application Composer to configure warning emails about milestone compliance events.
D. Use Application Composer to include milestones on the Service Request Layout if desired.

Answer: ABD

NEW QUESTION 4
Your customer has informed you about a possible error in the screen pop-up when receiving a call. The problem is that the edit contact screen pop is shown
whenever a call is received but most of the time the calls are regarding open Service Requests. As a result, agents have to navigate to that page, losing time and
being ineffective.
What is causing the problem?

A. Rules do not follow an orde
B. When a call is received, the “edit contact” screen pop appears because it is the default rule that has been selected, regardless of the service request number or
other tokens received.
C. Rules follow a priority orde
D. When the system finds a contact token it automatically opens the “edit contact” page, because that rule has been configured before the Service request rule,
regardless if a service Request token is also available.
E. A configuration in the pages tab of the screen pop is missing, the URL to the page to be displayed has not been provisione
F. The URL is empty so the system shows the contact edit page.
G. Screen pops are not configurabl
H. When a call arrives, the system automatically opens the page of the object in question, these cases being the contact page.

Answer: C

NEW QUESTION 5
You have been asked to manage the availability of Knowledge articles. The requirement is that agents, internal users, and external users should all have a way of
accessing the articles.
Which three options achieve your customer’s requirement?

A. Make them available to external users by giving them access to the internal “My Knowledge” page.
B. Make them available externally to customers via My Digital Customer Service (DCS).
C. Make them available to employees and agents via My Knowledge.
D. Make them available internally to agents as part of the Service Request Knowledge Panel.
E. Make them available for users with the “Knowledge Analyst” and “Knowledge Manager” roles only.

Answer: BCE

NEW QUESTION 6
To create a new Survey object, you create a sandbox and set it as active.
Which two statements are correct while creating your Survey object in Application Composer?

A. Multiple users cannot use your sandbox at the same time.
B. You can set a second sandbox as Active at the same time in order to begin working on another new object.
C. Your changes won’t be available to any other sandbox or to any application in the mainline application layer until you have published your sandbox.
D. Your changes are isolated and do not impact other users’ configuration environments or the production environment.

Answer: CD
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NEW QUESTION 7
You created two assignment rules for service requests using the Use Score option. For some service requests both rules return a result with the same total points.
What will be the expected result in the assignment of a queue for these service requests?

A. An error will occur; no queue is assigned to the service request.
B. The queue defined in the first evaluated rule is always assigned to the service request.
C. The queue defined by default is the one assigned to the service request.
D. The service request assignment will be unpredictable.

Answer: B

NEW QUESTION 8
Which option describes the automated page presentation for incoming calls?

A. a feature that displays a caller-appropriate application page based on your customer’s native languagewhen you answer your phone
B. a feature that displays a caller-appropriate application page based on a set of navigation rules defined for your customer when you answer your phone
C. a feature that displays a detailed caller profile based on a customizable set of parameters defined for your customer when you answer your phone
D. a feature that displays a detailed caller profile based on your customer’s country when you answer your phone

Answer: D

NEW QUESTION 9
Which three steps are required to configure the system to send an email notification when a milestone has reached warning status?

A. Add an extension column to the milestone object to hold the warning threshold value.
B. Configure an analytics report showing milestones in warning status.
C. Specify the warning threshold for the milestone in the standard coverages.
D. Create standard text to be posted to the message thread.
E. Configure the email template to be used for notification.
F. Configure an object workflow action to send the email when the milestone status changes to warning.

Answer: BCE

NEW QUESTION 10
You are creating a shared SmartText entry. Which option do you need to select to define a time period during which the entry is available to users?

A. Time Period
B. Duration
C. Available
D. Interval
E. Start/Stop

Answer: B

NEW QUESTION 10
You are starting a new Engagement Cloud project implementation, and one of your customer requirements is to share service request information through Oracle
Social Network.
In which way can you enable the service requests to be shareable on Oracle Social Network?

A. Setup and maintenance > Service > Setup > Productivity Tools > Manage Oracle Social Network Objects for Service
B. Setup and maintenance > Service > Configuration and Security > Service Request > Manage Oracle Social Network Objects for Service
C. Setup and maintenance > Sales > Service Request > Manage Oracle Social Network Objects
D. Setup and maintenance > Service > Setup > Productivity Tools > Manage Custom Objects for Service

Answer: B

NEW QUESTION 15
Your customer wants to have a vertical Media Toolbar instead of the Horizontal one. Which statement is true?

A. The only Vertical Toolbar that you can enable is the Notifications Toolbar.
B. The Horizontal Toolbar is always required, while the Vertical Toolbar and notifications are optional.
C. The Vertical Toolbar is always required, while the Horizontal Toolbar and notifications are optional.
D. You must set the Vertical Toolbar as the Default, and deactivate all Horizon Toolbars.

Answer: D

NEW QUESTION 20
Your client has noticed that inbound emails from customers are not creating or updating service requests. Which step should they perform to automate it?

A. Adjust the inbound message filters.
B. Enable SVC_SR_INBOUND_EMAIL_AUTO_UPDATE.
C. Adjust permissions on all customer’s profiles.
D. Enable SVC_ENABLE_INBOUND_EMAIL_DEFAULT_PROCESSING.

Answer: B
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NEW QUESTION 25
Which statement is correct when describing the process of adding assignment rules from Service Setup?

A. Use the “Manage Service Assignment Rules” task, access the appropriate rules sets, create new rule(s), add conditions and actions, save and publish.
B. Use the “Manage Service Request Assignment Object” task, access and lock the appropriate objects, create new rule set(s), add conditions and actions, save
and publish.
C. Use the “Manage Service Assignment Rules” task, access and lock the appropriate rules sets, create new rule(s), add conditions and actions, save and close.
D. Use the “Manage Service Request Assignment Object” task, access the applicable service requests, create and apply new rule set(s) to the service requests,
add conditions and actions, save and close.

Answer: D

NEW QUESTION 26
Identify two correct options about Application Composer, as the primary web-based tool within Engagement Cloud used to modify standard and custom objects.

A. It allows edits to dashboard pages.
B. It requires the use of a sandbox to modify the fields associated with standard and custom objects.
C. It requires proper permissions to use the tools and additional permissions to edit the desired object.
D. In includes a preview option for all standard and custom object pages.

Answer: B

NEW QUESTION 29
Which two are true characteristics about the lifecycle of a service request?

A. If required, users can manually set the “Closed” status for a service request.
B. Users can reopen a service request when the status is set to “Closed”.
C. Users can reopen a service request when the status is set to “Resolved”.
D. “Closed” status is set by an automatic job after a specified number of days.
E. “Customer working” is one of the five seeded status types.

Answer: CD

NEW QUESTION 31
Your client needs to associate a product item to a product group but cannot make the association. What should you check to identify the cause?

A. Validate that the product item is active and published.
B. Verify that Eligible for Service is selected on the product item.
C. Verify that Root Catalog is selected on the product groups.
D. Validate that Allow Duplicate is selected on the product item.

Answer: A

NEW QUESTION 33
Which three subobject functions are included in the REST API for Service Requests (SRs)?

A. Update SR reference
B. Update resource manager
C. Delete activity
D. Update resource member
E. Delete message

Answer: ACD

NEW QUESTION 36
Milestones are a key component of Service Entitlements. Identify three correct options regarding milestones.

A. Milestones are customizable by an administrator to include any number of organization-specific milestone types.
B. Milestones are actions on a service request (SR) that must be completed by a specific time.
C. Milestones can be one of four default types: ‘First Response’, ‘Second Response’, ‘Final Action’, and ‘Resolution’.
D. Milestones can be configured to start, pause, or complete based on a complex expression with AND, OR, and parentheses.
E. Milestones are commitments to handle SRs within certain timelines.

Answer: ACD

NEW QUESTION 38
What is the main function of the Data Security Policies?

A. defines the data a particular user can see and/or modify
B. defines the views the application can access
C. defines the privileges and roles a particular user can have
D. defines the views or functionalities the user can access
E. defines the actions a particular user can do

Answer: D
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NEW QUESTION 39
To create a service request, you log in to Engagement Cloud, navigate to service > Service Request and then click “Create Service Request”.
Which set of field must be completed to save the service request (assume as-delivered field properties have not been changed)?

A. Title, Status
B. Title
C. Title, Category, Severity, Status
D. Title, Status, Problem Description
E. Title, Category, Severity

Answer: C

NEW QUESTION 40
What should you do to enable Password Reset in Digital Customer Service (DCS)?

A. Add the Password Reset component to your DCS application.
B. Instruct users that they can only change their password by chatting with an agent.
C. Enable the “Password Reset” option in the User Administration component.
D. Obtain the Change Password Link and add it to your DCS page.

Answer: D

NEW QUESTION 45
Which three types of data are included in the interaction associated with a normal call flow?

A. Start time of the call
B. Agent name
C. Service Request create date
D. Contact name
E. Channel

Answer: BCD

NEW QUESTION 48
What three things should you perform to show product images in the Product Picker component in Digital Customer Service (DCS)?

A. Add images as the product image will not be pulled from Engagement Cloud.
B. Add the Product object to your DCS application.
C. Add product ID(s) to the database component.
D. Configure products groups and product items in Engagement Cloud.

Answer: BCD

NEW QUESTION 49
You have been instructed to implement the “My Knowledge” page for your customer’s Engagement Cloud site.
Which is the correct first action in configuring “My Knowledge”?

A. Use the task “Manage Administrator Profile Values”, search for the “Enable My Knowledge Menu for All Users” profile option, and activate it.
B. Use the task “manage Administrator Profile Values”, search for the “Enable My Knowledge Menu for Service” profile option, and activate it.
C. Use the task “Manage Service Request knowledge Profile Options”, search for the “SVC_ENABLE_KNOWLEDGE_PAGE_EXTERNAL_USERS” profile
option, and set “Site” value to “Yes”.
D. Use the task “Manage Service Request knowledge Profile Options”, search for the “SVC_ENABLE_ARTICLE_CREATION_EDITION” profile option, and set
the “SITE” value to “Yes”.
E. Use the task “Manage Administrator Profile Values”, search for the “Enable My Knowledge Menu for Help Desk” profile option, and activate it.
F. Use the task “Manage Service Request knowledge Profile Options”, search for the “SVC_ENABLE_KNOWLEDGE_IN_SR” profile option, and set “SITE”
value to “Yes”.

Answer: A

NEW QUESTION 50
Your customer asked you to modify the default severity value for new service requests. Which three steps should you follow to make the change?

A. Navigate to Setup and Maintenance > Service > Service Request > Manage Service Request Profile Options.
B. Select the profile SVC_SR_DEFAULT_SEVERITY_CD.
C. Lock the Profile Option for editing.
D. Modify the Profile Value and save.
E. Unlock and publish the new selected profile value.
F. Select View > Detach.

Answer: BDE

NEW QUESTION 55
Your customer is not able to use category filters for search and recommended results of Knowledge articles in his environment.
Which of the following is causing this behavior?

A. The user doesn’t have the role ENABLE_LOCALE_FILTER_ROLE.
B. The profile CSO_ENABLE_KNOWLEDGE_FAVORITING is set to N.
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C. The batch job for recommendations has not been executed.
D. The profile CSO_ENABLE_SVC_KMHOME is set to Y.
E. The profile CSO_ENABLE_CATEGORY_FILTER is set to N.

Answer: A

NEW QUESTION 57
Which six Digital Customer Service (DCS) parts can be modified using Visual Builder Cloud Service (VBCS)?

A. Object triggers
B. Templates
C. Business objects
D. Languages
E. Object workflows
F. Pages
G. Themes
H. UI components

Answer: ABCEFG

NEW QUESTION 62
You have been asked about some of the features of CTI notifications. Users want to be efficient in their time use, using alternate browser pages to carry out other
activities when they are not receiving calls. However, the priority remains answering their client’s calls, so they are forced to remain on the Engagement Cloud
Page to avoid missing them.
Perform an analysis on the available features of Engagement Cloud and select the best viable answer to your customer’s issue.

A. Engagement Cloud supports push notifications sent to mobile phones, so users can be aware via phone when a client is calling.
B. A toast notification option is present, which consists of desktop notifications popping up regarding incoming calls, whether they are currently on the Engagement
Cloud browser page or not.
C. A floating toolbar notification center can be configured, that is present all the time in the agent’s screen to inform him/her of incoming calls, whether they are
currently on the Engagement Cloud browser page or not.
D. There is not current feature that may help users be aware of the presence of an incoming call if they are not currently in the Engagement Cloud browser page.

Answer: C

NEW QUESTION 63
If you did not use the Reference Implementation template for your Digital Customer Service (DCS) application, you will .

A. not be able to preview your application before you publish it
B. have to contact Oracle Support for the permission to deploy your custom DCS application
C. be required to map roles so that the Visual Builder Cloud Service role matches the Engagement Cloud role
D. be required to create all of your own components for the display of Engagement Cloud objects

Answer: D

NEW QUESTION 66
Milestones are not getting applied to service requests in the customer environment. Identify three causes.

A. The scheduled process has not been set up.
B. The Starts When criteria of the milestones is not True.
C. No default coverages are set up.
D. Entitlement rules are not valid for the service request.

Answer: ABC

NEW QUESTION 67
Which two statements are true regarding the Audit History tab of a Service Request?

A. It is enabled by default.
B. It is available only to authorized administrators.
C. It is searchable by date range, username, event type, event severity, and event duration.
D. It is exportable to Excel.
E. It allows users to save searches for later reuse.

Answer: AE

NEW QUESTION 68
......
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